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Risk Disclosure & Copyright  

Risk Disclosure Statement 
Trading any financial market involves risk. This Manual is neither a solicitation nor an offer to 
Buy/Sell any financial product. The contents of this Manual are for general informational purposes 
only. 

Although every attempt has been made to ensure accuracy, the author does not give any expressed 
or implied warranty as to its accuracy. The author does not accept any liability for error or omission. 
All examples are provided for illustrative purposes only and should not be construed as investment 
advice.  

No representation is being made that any account, or trader will, or is likely to achieve profits or 
loses similar to those discussed in this Manual. Past performance cannot be relied upon as being 
indicative of future performance.  

By purchasing the Forex Morning Trade System manual and any associated personal training and 
coaching you will be deemed to have accepted these terms in full. The author does not and cannot 
give investment advice or invite customers to engage in specific investments.  

The information provided in this Manual is not intended for distribution to, or use by any person or 
entity in any jurisdiction or country where such distribution or use would be contrary to law or 
regulation or which would subject the author to any registration requirement within such jurisdiction 
or country.  

Hypothetical performance results have many inherent limitations, some of which are mentioned 
below. No representation is being made that any account will or is likely to achieve profits or losses 
similar to those shown. In fact, there are frequently sharp differences between hypothetical 
performance results and actual results subsequently achieved by any particular trading system.  

One of the limitations of hypothetical performance results is that they are generally prepared with 
the benefit of hindsight. In addition, hypothetical trading does not involve financial risk and no 
hypothetical trading record can completely account for the impact of financial risk in actual trading.  

For example the ability to withstand losses or to adhere to a particular trading program in spite of 
the trading losses are material points, which can also adversely affect trading results. There are 
numerous other factors related to the market in general or to the implementation of any specific 
trading program, which cannot be fully accounted for in the preparation of hypothetical performance 
results. All of which can adversely affect actual trading results.  

All rights reserved  

The content of this Manual is copyrighted. No part of this publication may be reproduced, stored in 
a retrieval system, or transmitted in any form or by any means - including electronic, mechanical, 
photocopy, recording, scanning or otherwise - without the prior written permission of the author.  

This ebook cannot be resold. This ebook is only sold at http://www.forexmorningtrade.com. If you 
bought the ebook from any other place, you have an illegal copy. 

© 2010 Mark Fric, SonarBytes Ltd, Prague, Czech Republic 

http://www.forexmorningtrade.com/
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1 Introduction 

This is the manual for ForexMorningTrade EA (version 4.0). 

ForexMorningTrade_EA is an Expert Advisor (robot) for MetaTrader4 that can be used to trade the 
Forex Morning Trade system automatically. 

This manual describes only the Expert Advisor, not the manual system. I recommend you to read 
the description of the manual trading system first, to know its rules, entries and exits before 
using the Expert Advisor. That way you will be able to control what the EA is doing. 
Please check ForexMorningTrade_manual.pdf for information about my trading system. 

This robot is given “as is”, without guarantee of any kind. You use it at your own risk. 

Having said that, I took every effort to make the robot stable and reliable. I use it to trade on 
my own live account. 

If you’ll experience any problem with the robot, please check the Troubleshooting section of 
this manual first. If it doesn’t solve your problem, contact me using the support email below. 

 

 

 

 

 

 

 

 
  

Support 

If you'll have trouble understanding anything, you need help, or you simply have some question 
to ask (related to the system), remember your purchase includes also a support.  

I'm here for you, contact me at: 

support@forexmorningtrade.com 
 

mailto:support@forexmorningtrade.com
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2 Requirements 
 

This Expert Advisor is a robot, it means that it runs on MetaTrader 4 platform and automatically 

places trade every morning according to the rules of Forex Morning Trade system. 

This way you don’t need to wake up early in the morning and check the signals by yourself. You can 

let this robot do the work. You can even go for a holiday and let the robot trading. However, you 

should overview the trading results every day at least in the beginning. You never know what could 

happen, so you should watch your trades even if they are placed by robot. 

What you’ll need to trade automatically: 

 MetaTrader 4 – you should have it already for manual trading 

 EA – it is given to you together with this book 

 Computer that is turned on all the time, or VPS 

I trade some of my systems automatically. When I started with trading I used small netbook - Asus 

EEE - that was turned on all the time and I had few MetaTraders installed on it that were running 

different EA robots. 

Now I use VPS and I highly recommend using VPS for serious trading. VPS stands for virtual private 

server, and it means that you can rent a virtual server with Microsoft Windows installed. The server 

is physically placed at the hosting company and you can access it only through internet. VPS behaves 

like standard computer; you can install new programs there, run them, etc. 

 VPS has many advantages over your small computer at home, because it runs 24/7, it is managed 

by a professional hosting company, it is not affected by power or internet failures at your home 

and it also has much better internet connection speed. 

I personally use VPS from Commercial Network Services, and I can highly recommend them.  

They have special offer for traders. The pricing starts at $30 per month. 

http://www.commercialnetworkservices.com/VPS/Windows/Traders/ 

You can find other offers starting at around $9 per month if you’ll search for “forex vps” on Google.  

I recommend you to check some reviews before you choose your VPS, because there could be big 

differences in quality. 

 

  

http://www.commercialnetworkservices.com/VPS/Windows/Traders/
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3 New features 

The current version is Version 4 – the file is ForexMorningTrade_EA_4.0.ex4 
 
Changes from previous version: 

 Added "stealth' mode to hide profit target and stop loss from brokers 

 Added possibility to send email after signal 

 Added Money Management function - risking fixed percentage of the account 

 When BE rule is activated, added possibility to move Stop Loss to entry price + X pips 

Version 3  
 
Changes from previous version: 

 Added possibility to move SL to BE after given profit is reached 

 Added trailing stop 

 Added Last Signal log message to the chart  

 Fixed problem with requotes and multiple copies of EA running 
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4 EA parameters & features description 

 

4.1 "Stealth" mode to hide actual Profit Target and Stop Loss from brokers 
 

Stealth mode can be used if you think your broker might be cheating you by hunting for your Stop 

Loss. Every broker can normally see where the stop loss and profit target is placed for every order. 

Dishonest broker can then manipulate the price to get you into the stop loss or avoid hitting your 

profit, even if the price in reality would not go that way. 

I still believe that the best way to avoid pips hunting is choosing a big and respectable broker, but 

some of my customers requested this stealth feature so I added it. 

There are now two pairs of Stop Loss and Profit Target parameters. 

BrokerProfitTargetPips, BrokerStopLossPips - are the parameters that will be set as Stop Loss and 

Profit for your order and brokers will see them. 

HiddenProfitTargetPips, HiddenStopLossPips - are the parameters that are visible only by EA, and 

that are used to exit the trade when the price reaches either of them. Brokers don't see these 

parameters. 

So if you'll set BrokerProfitTargetPips = 50 and HidenProfitTargetPips=40, the EA will place Profit 

Target to 50 pips (broker will see that), but the  trade will be closed when it reaches the 40 pips. 

If you want to use this feature, I recommend setting the BrokerProfitTargetPips and 

BrokerStopLossPips little bit bigger than real profit target and stop loss (HiddenProfitTargetPips and 

HiddenStopLosssPips). 

If you don't want to use this feature, simply set both (Broker and Hidden) parameters to the same 

value. 

 

 

  

Note 
 

The HiddenProfitTargetPips and HiddenStopLossPips will work ONLY if your Metatrader 

and EA is up and running. Your computer must be turned on all the time if you'll use 

this option.  
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4.2 Money Management 
 

Money management is a powerful feature that allows you to define EA how big percentage of your 

account it should risk for one trade. I recommend risking maximum 2-3 % of your account. 

There are five parameters for money management. 

UseMoneyManagement - if you set it to false, it will disable the money management, the EA will 

trade the amount of lots specified in Lots. This is the default settings. 

If you want to use money management, set UseMoneyManagement=true. 

With active money management you have to specify RiskInPercent, setting it to 2 means you want to 

risk 2% of your account per trade. I recommend risking not more than 2-3 % of your account, so you 

can set 2 or 3 there. 

Then you have to specify LotsDecimals which is a precision to which the EA should round the number 

of lots. Some brokers  allow 2 decimal places for lots,  while others (like PFG Best) allow only one 

decimal place for lots, which means with them you can use 0.7 lots, but not 0.71. 

This depends on your broker, if you are not sure you can leave 2 decimal places there and if the EA 

will not trade check if the problem is not in incorrect lots size. 

A security setting is MaximumLots, it is the maximum amount of lots you want to allow the EA to 

trade. This is a security precaution in case something will go wrong with computation or you'll make 

some mistake, the EA will not trade with more lots than defined here. 

 

4.3 Email after trade 
 

EA is now able to send an email confirmation after placing a trade. You can enable it by setting 

parameter SendEmailAfterSignal=true, but that's not everything you need to do. 

To allow sending emails, you have to configure the SMTP server settings in Tools -> Options -> Email. 

This is a Metatrader functionality and I'm NOT PROVIDING ANY SUPPORT regarding this, it is beyond 

the scope of trading system or my Expert Advisor. Please check the Metatrader help or with your 

broker how to set it up. 

The screen to set up the SMTP server looks like this: 
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4.4 Possibility to move SL to BE after given profit is reached 
 

You can use this functionality with the new BreakEvenAtPipsProfit parameter.   

The EA will move your SL to BE (entry price or few pips more) once the price reaches given number of 

pips. This protects your money from an unexpected market turn, when it first gets close to your 

profit target, but then turns the other way and heads to your Stop Loss. 

I recommend using this feature; it reduces drawdown and improves profit factor and total gain of the 

system. The difference is not dramatic, but anything that improves the performance is a plus. 

New! You can now use variable BreakEvenAddPips to move Stop Loss not to entry price, but to few 

pips more, so that in worst case you'll not end up with zero, but with at least few pips profit. 

This is mainly psychological help, because my backtests show that using this functionality doesn't 

help the performance at all. 

 

4.5 Trailing Stops 
 

There is a TrailingStopPips parameter that you can use to set trailing stop. Trailing stop is a special 

command that will move the stop loss always X pips under the highest market price achieved. 

So if the market is growing, you don’t need to close the order at the fixed price but instead of this 

just put your profit target 100-150 pips higher and use trailing stop to move with the market. Once 

the markets starts turning back, it will hit the trailing stop and closes the trade. 

You should realize that the trailing stops are tied with Profit target. When you’ll use trailing stop, you 

should set much bigger profit target than the standard 40 pips. 

Trailing stops can be used when we expect larger market moves and we want to catch as much of the 

move as possible. However, trailing stops are not ideal for all conditions. If the price goes close to our 
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standard 40 pips profit target, and then turns back, we’ll make much less with trailing stop than with 

fixed profit target. 

I recommend setting TrailingStopPips=40 pips and ProfitTargetPips=80 pips. 

Setting the Profit target to “only” to 80 pips proved to be the best setting in my backtests. There 

won’t be many trends that will go more for than 80-100 pips, so we’ll get  these 80 pips quite often. 

 

4.6 Last Signal log message in the chart  
This is a log message that displays the last signal taken by the EA and success or error message on 

placing an order.   

So if your EA misses the trade, you should be able to find the description of an error there. 
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5 Installing the Expert Advisor 
 

The Expert Advisor is available with this book (file ForexMorningTrade_EA_4.0.ex4) . 

Before doing anything, shut down MetaTrader. The EA  file (ForexMorningTrade_EA_4.0.ex4) has 
to be copied to the directory /experts of your installed MetaTrader software, for example: 
C:/Program Files/MetaTrader4/experts 

After you copied the file you can start MetaTrader. 

If you are already running previous version of this EA (named ForexMorningTrade_EA), you can 
overwrite the file, then restart your MetaTrader and check the correct settings. 

  

6 Starting the Expert Advisor 

Before we start the robot, we should make sure we have correct configuration. 

In MetaTrader, go to Tools -> Options 

 

Then, go to Expert Advisors tab. Make sure that Enable Expert Advisors and Allow live trading are 
checked, and that Ask manual confirmation is unchecked. 
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When everything is correct, we can start the Expert Advisor. Expert Advisor is always running on one 
particular chart. So you should have chart for GBPUSD on 15M timeframe ready. 

The best is if it also contains the FxMorningTrade indicator so that you can see that the trades were 
placed at the correct time, and you can also quickly check the indicator values. 

 You can find out how to install the indicator and chart in the Forex Morning Trade manual. 

Now go to the Navigator window, open Expert Advisors. You should see ForexMorningTrade_EA 
there. 

If you don’t see the Navigator window in your MetaTrader, you can open it in View -> Navigator 
menu.  

Make sure that you are really working with GBPUSD on 15M timeframe (you can see it in the top left 
corner of the chart), and then double click on the ForexMorningTrade_EA in Navigator. 
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This will open dialogue with EA parameters. 

 

 

Please refer to the ForexMorningTrade manual to find out more about lots size and trading time. 
Also, read the following chapter with recommended settings for these parameters. 

You have to configure trading hour and minute – it should be the same setting you use for manual 
trading. In my example I set the time to 7:30, it is Alpari UK trading time. 

Also, pay attention to Lots. This is the amount of lots the system will be trading. You should compute 
it according to the money management rules and the size of your account. Or you can use the money 
management feature that will trade with predefined amount of your account. 

Trading with 0.1 lot means that 1 pip will have value approx. 1 USD, so you’ll earn or lose 40$ per 
every trade. 

If you’ll trade with 1.0 lot, you’ll earn or lose $400 per every trade. 

When we configured TradingHour, TradingMinute, Lots and BreakEvenAtPipsProfit, we can click on 
OK button, and our Expert Advisor will be active. This means it will be running, and every day at 7:30 
(in this example) it will check for signal according to Forex Morning Trade rules and opens an order. 

It will also automatically place Stop Loss and Profit Target with this order, so you don’t need to do 
anything except checking the results. 

You can check that the Expert Advisor is running by looking at the top right corner of the chart. It 

should show ForexMorningTrade_EA and a smiling face. 

Smiling face means that it is running properly. If the face is not smiling, you probably didn’t enabled 

Live trading or Expert Advisors in the previous steps.  
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Closer look at the top right corner: 

 

Closer look at the bottom left corner: 

 

This is a log message that will show you the last signal taken by the EA and success or error message 

on placing an order. 

 

This is all. Now we have running robot that will make a trade every morning at 7:30. 

 

If you have never traded with an EA before, try it with as little lots as possible first to make sure it 

works as expected. This way, even if something goes wrong, you won’t lose too much money. 
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Warning 
 

You cannot turn off MetaTrader or your computer if you want the robot to run. 

If MetaTrader or computer is turned off, the robot will stop working! That’s why you should use 

computer that is always on, or a VPS. 

 

Note 
 

If you want to check or change the robot parameters, use the F7 key or double-click on 

the smiling face next to the EA name in the top right corner of the chart. This will show 

you parameters of a running robot. 

Double clicking on the EA name in the Navigator will always display only default settings, you 

must use F7!  
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7 Recommended settings 
 

I tested various configurations and the best results were achieved by applying only the BreakEven 

feature without the Trailing Stop, with StopLoss = 40 pips and ProfitTarget = 35 pips. 

This setting came as the best and most stable year by year according to my backtests (1, 2, 4 years 

back). 

So the recommended settings for the parameters are: 

 

HiddenProfitTargetPips = 35  // the real values 

HiddenStopLossPips = 40  

 

BrokerProfitTargetPips = 55  // values visible by broker, higher than real values 

BrokerStopLossPips = 55  

 

BreakEvenAtPipsProfit=20 

TrailingStopPips=0 

 UseMoneyManagement = true //Use Money Management 

Lots = 0.1    // this has no effect when we use money management 

LotsDecimals = 2   // this depends on your broker, it is safe to set it to 2   

RiskInPercent = 2   // we risk 2% of account per trade 

MaximumLots = 0.5   // maximum lots you want to allow EA to trade 
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8 Troubleshooting and FAQ 
 

My robot is not trading, what should I do? 

There are various reasons why the robot isn’t working or why it missed a trade. 

Please check the following things before contacting me: 

1. The face next to the robot name on the top right corner must be smiling – if the face is not 

smiling it means that the robot is not active. You probably didn’t configure properly the 

MetaTrader settings – you didn’t allow Expert Advisors or Live trading. Please refer to the 

Starting the Expert Advisor section in this manual. 

 

2. The face is smiling, but the robot missed a trade – please check that you have set correct 

trading time and Lots. Some brokers don’t allow trading with microlots, so make sure you 

configure the Lots properly. 

There is also a new log message at the left bottom of the chart. Please check what the error 

message says. 

 

Can I turn off the computer after the trade was placed? 

Generally you can. When the trade is already opened and it has proper Stop Loss and Profit Targets 

set, you can turn off the computer and the trade will run until it hits either profit or stop loss.  

But you have to realize that your robot will stop working when your computer is turned off even if 

your trade is still active.  So if you configured moving SL to BE (using BreakEvenAtPipsProfit 

parameter), or trailing stop (using TrailingStopPips parameter), these features will not work when 

the robot is not running. 

 

Will the robot automatically close the trade at the end of the indicator blue zone? 

No, the blue zone is used only to indicate the entry time. The end of the blue zone doesn’t mean 

anything; we run the trade until it hits either Profit or Stop loss. 

 


